ESA UNCLASSIFIED - For Official Use
(N

€-esa

=

/"-

-~
i

y

ecsat

Fermi Avenue

Harwell Campus

Didcot, Oxfordshire 0X11 OFD
United Kingdom

T +44 (01235 444200
www.esa.int

STANDARDS

CCI Data Standards

Prepared by ESA Climate Office

Reference CCI-PRGM-EOPS-TN-13-0009
Issue/Revision 2.3

Date of Issue 26/07/2021

Status For Information Only

European Space Agency
Agence spatiale européenne



ESA UNCLASSIFIED - For Official Use

&K\\\\L
€-esa
CHANGE LOG

Reason for change Issue Nr. Revision Number | Date

First issue of Data Standards Requirements (Victoria 1 0] 20/05/2013
Bennett & Sarah James)

Revision incorporating comments from DSWG (Victoria 1 1 24/05/2013
Bennett & Sarah James)

Changing definitions in section 2.1 of source global 1 2 09/03/2015

attribute, platform attribute, and Envisat term in
Section 2.1, Appendix A and section 2.7 Product String
examples §

Rearranged content, added more examples, additional 2 0] 17/09/2018
requirements and clarifications ahead of, and following,
CCI Colocation March 2018 and to apply during CCI+
Led by Ed Pechorro (ESA), Alison Waterfall (CCI ODP),
Victoria Bennett (CCI ODP) and supported by Kevin
Marsh (ECMWF) and Cedric Bergeron (ECMWF).

Version v2.1 produced based on feedback for v2.0. Led | 2 1 25/03/2019
by Alison Waterfall (CCI ODP)

Version 2.2. released (Led by Alison Waterfall, CCI 2 2 19/05/2020
ODP)

Version 2.3. released (Led by Alison Waterfall, CCI ODP 2 3 26/07/2021

Task, CCI Knowledge Exchange))

Page 2/24
CCI Data Standards European Space Agency
Issue Date 26/07/2021 Ref CCI-PRGM-EOPS-TN-13-0009 Agence spatiale européenne



ESA UNCLASSIFIED - For Official Use

Table of contents:

1  BACKGROUND ... .ccitttienrenrenrenresenseesessesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 4
2 PRODUCT GUIDELINES....cccicttutttttectetiectecrecsecsssssssssssssssssssssssssssssssssssssssssssssssssssss 5
2.1 Standard products: MiNiMUM FEQUITEIMENTS ......c.ceceeererirererereeesesesesessessessessessessessessessessessens 5
2.2 Products for existing USEr COMMUNITIES.......coeeieieirieieieeeeeteeteeeeeeeeeseeste e ssesaessessesaens 5
2.3 Conformance with international standards............cccceeeveeiieeieeeiececeereceee e 6
2.4 CCT OMNEOLOZY -.cevevereruieneniieieeieeteteteeeetee et e see e s s e sseesessessessessessessessessessessessassessessessessessensensessasansen 6
2.5 FIIE CONTENTS ...uveiiiieieeieeeeeceece ettt ettt e rte e te e e e e saeeeseeesaeesaeeseeesseesseesseessaessaenssenssennsaeseenssanns 7
2.5.1 GlODAl ATITIDULES ... vecvieeeieeeeeeeeeeeteee ettt te e ste et eeee e saeeesa e e s e ebeeesseessessaessesssesnsaenseenssenns 7
2.5.2 VATIADIES ...ttt ettt et e et e e ae e e te e ae e aeeeas e e be e ae e e b e eae e seeeateeseesaeenaaenraan 9
2.5.3 Gridded data — coordinate variables .............ccueeueeeiecieeiieeeeeeeee e 10
2.0 DITECLOTY SITUCTUTE. .....eitiiuiiiietiieeteee ettt ettt et e eb et b et sae et s se st e s st e bessessnessens 12
2.7 FIlENAMING. ... ccciiiiiciieiecieetcceeteecet et ste s e st e s e et e s e e sae st e se st e bassaassesstassaessassaessensaensansasssensaans 13
2.8 Version NUIMDETINE ......cccceiririririeieerieeeteeeieeteeeeieeseesessessessessessessessessessessessessessessessessessessensens 22
2.9 Support for checking compliance with the data format..........cccoceeeeerininininineeeene 22
APPENDIX A — EXAMPLE GLOBAL ATTRIBUTE FIELDS ....ccccccctctctctcesecececescscssasenes 23
Page 3/24

CCI Data Standards

European Space Agency
Issue Date 26/07/2021 Ref CCI-PRGM-EOPS-TN-13-0009 Agence spatiale européenne



ESA UNCLASSIFIED - For Official Use

=

///&

]

=
f——
(7

-CSa

1 BACKGROUND

The ESA Climate Change Initiative (CCI) is a programme which is generating a set of validated, error-
characterised, Essential Climate Variables (ECVs) from existing satellite observations. The CCI
Programme was launched in 2009 and initially consisted of thirteen Projects, each addressing a
particular ECV, and CMUG, the Climate Modelling User Group. CCI+ began in 2018, building on this
earlier work and introducing a further set of ECV’s.

This document is based on the “Guidelines for Data Producers — CCI Phase 1™, and the subsequent
“Data Standards Requirements for Data Producers™. The motivation and content for these
documents came from the first CCI collocation meeting in September 2011, subsequent discussions
at the CCI collocation meeting, the CCI integration meetings and within the Data Standards Working
Group. The start of the CCI+ programme provided the opportunity to revise the data standards
outlined in this document in the light of the experience of the earlier phases of the CCI programme,
with version 2.1 released in summer 2019. This version provides a subsequent update to the
document.

This document provides the minimum requirements to CCI data producers to ensure consistency
between output products from the CCI projects. The requirements in this document are intended to
apply to all CCI projects in CCI+.

In case of new developments (e.g. due to evolving user requirements, international standards and
formats), these requirements may still evolve during the course of the programme. Any updates will
only be made after discussion with, and agreement in the CCI Data Engineering Working Group.

The overall aim of these standards is to make the CCI datasets as widely usable as possible, in user
communities outside the existing ones. Using common formats and a number of agreed and
consistent metadata conventions will facilitate this. Further help and advice on data formatting and
support for checking compliance with these standards is available from the CCI Open Data Portal,
and CCI Projects are encouraged to liaise with the Portal when developing their data formats.

CCI Sustainability

Version 2.0 of the CCI Data Standards was the first edition of the standards developed with the
support of the European Centre for Medium-Range Weather Forecasts (ECMWF). A number of CCI
datasets have served as input to, and evolved under, ECMWF implementation of the Copernicus
Climate Change Service (C3S). The cooperation between the ESA Climate Office and ECMWF/C3S
on the CCI Data Standards, from v2.0 onwards, optmises the sustainability of CCI datasets beyond
the CCI programme, and facilitates their use and further development by ECMWF/C3S.

In addition, the CCI Data Standards supports a complementary activity between the ESA Climate
Office and ECMWF/C3S on climate data interoperability, following CCI Toolbox Iteration Review
Meeting 9 (IRM9) on 20 June 2018 participated by ECMWF/C3S : the development of a proof-of-
concept data link between the (ESA) CCI Toolbox API and the (C3S) CDS API.

CCI Data Standards v2.3 follows a joint announcement at the 2020 CCI Colocation by ESA and
ECMWEF that both parties are cooperating on an ESA-ECMWF Joint Data Standards for Satellite-
Based Essential Climate Variables. News of the cooperation was further shared with ESA delegates
at the CCI+ Mid-Term Review (MTR) in 2020.

1 CCI-PRGM-EOPS-TN-11-0003, issue 4, revision 1, May 2013
2 CCI-PRGM-EOPS-TN-13-0009, issue 1, revison 2, March 2015
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2 PRODUCT GUIDELINES

2.1  Standard products: minimum requirements

All CCI projects shall produce data according to the following minimum requirements for data
products:

CCI projects shall produce data according to the CCI Data Standards Requirements:
a. Produced in netCDF-4 formats
b. Conform with the CF (Climate and Forecasting) convention4 (currently version 1.8)
c. CF standard names used for the main variables

d. Include the global attributes listed in section 2.5.1 below

In earlier versions of the CCI Data standards, there was a requirement that data should be produced
in netCDF-4 classic format. The recent version of the CF (Climate and Forecasting) convention, now
allows some non-classic features, and this restriction has therefore been relaxed to allow the use of
new NetCDF 4 data types.5

However, datasets shall still only use features which comply with the current version of the CF
convention, citing the correct CF and CCI data standards version numbers in the relevant global
attributes field (see section 2.5.1 below).

The use of NetCDF 4 groups should only be used after discussion with the CCI data standards team.
For netCDF-4 compression can be invoked.

If netCDF-4 cannot be used (e.g. user tools not yet mature enough), data may be produced in netCDF-
3 format.

It is recommended that chunking of the datasets be considered when writing to NetCDF, particularly
in case of compression®. The appropriate chunking to use will however depend on the intended uses
of the product. If specified, it is recommended that the chunk size is an integer fraction of the
respective dimension (i.e. that there are no smaller chunks at a border).

2.2 Products for existing user communities

It is understood that existing user communities require data in specific formats that are not in all
cases compatible with the requirements in this document (e.g. GeoTiff, shape files).

Projects producing such files in other formats are required to follow these requirements as far as
possible in terms of filenaming and metadata for their non-standard data, and to produce a
standardised, netCDF format dataset, in addition to their domain specific datasets.

3 http://www.unidata.ucar.edu/software/netcdf/

4 http://cfconventions.org/latest.html

5 It is advised to avoid using a data type of int64, as this is not supported by the OPenDAP (DAP2) protocol. This is one of
the access methods used by the CCI Open Data Portal and Toolbox, so use of this data type may reduce the different services
which the data can be accessed via.

6 https://www.unidata.ucar.edu/blogs/developer/entry/chunking data why it matters
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Projects who have commitments to produce data in other formats, shall do this in
R-2 addition to the standardized products, and shall ensure these products comply as
much as possible to the CCI Data Standards (e.g. filenames, metadata)

2.3 Conformance with international standards

The choice of CF and ACDD” conventions for CCI data products ensures it will be possible to extract
the metadata from the files to a number of standard metadata formats, e.g. ISO19115, FGDC, etc, as
required by data discovery systems.

Within the CF-convention there are still areas where there are ongoing discussions. CCI data
producers who are producing such data products are strongly encouraged to engage with this
community to progress the development of CF conventions for satellite swath data, either directly or
via the Data Engineering Working Group, which can provide coordination for discussions with the
CF-community. Discussions on the cf-conventions generally and requests for new standard names
for geophysical variables used in CCI, can be made here: https://github.com/cf-convention/discuss

CCI Data Producers shall engage with the CF community to help develop the
standards they require for satellite data

R-3

The INSPIRE (Infrastructure for Spatial Information in the European Community) directive requires
INSPIRE compliant discovery metadata to be generated for geospatial datasets that are within scope
of the directive, which covers a broad range of environmental themes. All data products that are held
in the CCI Open Data Portal will have INSPIRE compliant metadata records created by the Data
Portal team? (see, for example:
https://catalogue.ceda.ac.uk/export/xml/gemini2.3/3628cb2fdba443588155e15dee8e5352.xml).

The CCI projects shall ensure that INSPIRE compliant metadata records are created
R-4 for each dataset held in the CCI Open Data Portal, by providing the required
information to the CCI Open Data Portal Team.

2.4 CCI Ontology

To ensure consistency where the same global attributes apply to several ECVs, and to avoid different
terms being used for the same thing, relevant terms have been gathered in an ontology, defining the
CCI entities and the relationship between those entities, including :

e project

7Attribute Convention for Data Discovery
(http://wiki.esipfed.org/index.php/Attribute Convention for Data Discovery)
8 In exceptional cases products are held in external sites with agreement from ESA
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e platform
e sensor
e institution

The CCI Ontology is available online at http://vocab.ceda.ac.uk/ontology/cci/cci-
content/index.html.

CCI Data Producers shall use terms from the CCI vocabulary tables in the netCDF
R-5 global attributes, or if terms are missing they shall request that they are added to the
tables.

2.5 File contents

2.5.1 Global Attributes

The following section outlines which global attributes shall be included in the files. Example content
for these attributes are given in Appendix A. For consistency, CCI output netCDF files shall include
these global attributes to provide usage information about the data:

a. title (succinct description of the dataset)
b. institution (where the data was produced, use names from CCI common vocabulary)

c. source (original data source(s), e.g. MERIS RR L1B version 4.02) Multiple source datasets
and ancillary datasets used, with their DOI if available, as a free-text, comma-separated list)

history (processing history of dataset)

references (references to algorithm, ATBD, technical note describing dataset)
tracking_id (a UUID (Universal Unique Identifier) value)s

Conventions (the CF Version e.g CF-1.8)

= R <9

product_version (the product version of this data file (see section 2.8))

o

format_version (the CCI data format used e.g. “CCI Data Standards v2.x”)

Discovery metadata allows information about the data to be harvested into catalogues and data
federations.  For  dataset discovery, the netCDF attributes recommended in
http://wiki.esipfed.org/index.php/Attribute Convention for Data Discovery shall be included in
addition to the attributes listed above:

j- summary (a paragraph describing the dataset)
k. keywords (a comma separated list of key words and phrases)
L. id

m. naming authority (the combination of the naming authority and the id should be a globally
unique identifier for the dataset)

9 The unique tracking ID allows files to be referenced, and linked up to processing description, input data, documentation,
etc. The software to generate the UUID can be downloaded from : http://www.ossp.org/pkg/lib/uuid/ and CCI shall use
version 4 (random number based) for consistency with CMIP5
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keywords_vocabulary (if you are following a guideline for the words/phrases in your
“keywords” attribute, put the name of that guideline here)

cdm_data_type (the THREDDS data type appropriate for this dataset)
comment (miscellaneous information about the data)

date_ created (the date on which the data was created)

creator_name

creator_url

creator_email

project (the scientific project that produced the data: “Climate Change Initiative — European
Space Agency”)

geospatial_lat_min (decimal degrees north, range -90 to +90)

. geospatial_lat_max (decimal degrees north, range -90 to +90)

geospatial_lon_min (decimal degrees east, range -180 to +180)
geospatial_lon_max (decimal degrees east, range -180 to +180)

geospatial_vertical_min (assumed to be in metres above ground unless
geospatial_vertical_units attribute defined otherwise)

geospatial_vertical_max (assumed to be in metres above ground unless
geospatial_vertical_units attribute defined otherwise)

time_ coverage_ start (format yyyymmddThhmmssZ)
time_ coverage_end (format yyyymmddThhmmssZ)
time_ coverage_ duration (should be an ISO8601 duration string)

time_ coverage_resolution (should be an ISO8601 duration string). For L2 data on the
original satellite sampling it is acceptable to use 'satellite_orbit_frequency'

standard_name_vocabulary (the name of the controlled vocabulary from which variable
standard names are taken e.g. 'CF Standard Name Table v77'.)

license (describe the restrictions to data access and distribution)

The following CCI project specific attributes shall be included in the files:

hh.

ii.

platform (satellite name, e.g. Envisat; use names from CCI common vocabulary list.
Separated by commas if more than one, and use angled brackets for a platform series, eg.
‘Envisat, NOAA-<12,14,16,17,18>, Metop-A’)

sensor (sensor name, e.g. AATSR, use names from CCI common vocabulary. Separated by
commas if more than one )

jj- spatial_resolution (a free-text string describing the approximate resolution of the product.
For example, “1.1km at nadir”. This is intended to provide a useful indication to the user, so
if more than one resolution is relevant e.g. the grid resolution and the data resolution, then
both can be included.)
kk. key_variables (a comma separated list of the key primary variables in the file i.e. those that
have been scientifically validated, and are appropriate for display in the CCI Open Data Portal
and CCI Toolbox. These should be identified using the variable id’s in the file)
Page 8/24
CCI Data Standards

European Space Agency

Issue Date 26/07/2021 Ref CCI-PRGM-EOPS-TN-13-0009 Agence spatiale européenne



ESA UNCLASSIFIED - For Official Use

\K\\\k
¢-esa

For gridded (level3/level4) data on a regular lat/lon grid, the following attributes shall be included
in the files (not compulsory for level2 data, or data on other grids, e.g. polar stereographic):

1l. geospatial_lat_units
mm. geospatial_lon_ units
nn. geospatial_lon_resolution

00. geospatial_lat_resolution

Projects are free to include any number of additional attributes which are specific to their domain or
user community, or for compatability with other external initiatives e.g. Copernicus C3S.

2.5.2 Variables

Variables should be stored in the NetCDF file in conformance with the CF-convention
(http://cfconventions.org/) and using the standard name attribute where appropriate. Where an
existing standard name exists this should be included as an attribute on the variable. Where a
standard name does not exist, or has not yet been accepted by CF, the standard name attribute should
not be included for that particular variable. Data producers are strongly encouraged to submit new
standard names for inclusion in CF as appropriate. Names can be proposed and discussed directly
here: https://github.com/cf-convention/discuss. The CCI Open Data portal team can also provide
advice on the process.

In addition the following should be considered:

a. The key primary variables in the file (i.e. those that are scientifically validated, and for
instance, are appropriate for visualisation through the CCI Portal and Toolbox), shall be
identified by the use of the ‘key_variables’ global attribute. This should be in the form of a
comma separated list.

b. Ancillary and coordinate variables should also be identified as specified in the CF
conventions4:

o Ancillary variables such as uncertainty or quality flags should be identified by the
‘ancillary_variables’ attribute of the related primary variable. Ancillary variables that are
required to correctly interpret a key primary variable must be identified in this way.
(Section 3.4 of CF-1.7 conventions document)

o Coordinate variables are identified as those with the same name as the corresponding
dimensions, whilst related auxiliary coordinate variables can be identified using the
‘coordinates’ attribute of a variable (Section 4 and 5 of CF-1.7 conventions document)

c. For each variable, the attributes ‘valid_range’ (or alternatively ‘valid_min’,'valid_max’) and
‘actual_range’ shall be provided, if appropriate.

o The ‘valid_range’ should define the expected valid range of the variable. Under the CF-
convention, values outside this range are treated as missing data.

o The ‘actual_range’ provides the actual range of the data within the file, within the limits
of the valid range.

d. Where quality flags are included, it is recommended that a value of ‘0’ (the number zero) or
no bits set is taken to indicate good quality data.

e. For variables with a defined colour table (e.g. for land cover classes), this colour mapping
information shall be included in the NetCDF file.
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In addition, to allow the datasets to be best displayed through the CCI Open Data Portal and CCI
Toolbox, display information are requested to be provided for the variables e.g. a recommended
colour bar and display min/max. Such information could be included in the comment attribute of
the respective variables, or alternatively could be provided outside of the data file, directly to the CCI
Open Data Portal.

The key primary variables in the file and their related ancillary variables (e.g.
uncertainty) shall be identified, and the range of their expected values shall be
indicated.

Example of including variables and corresponding attributes in the file :

float variablel (time, lat, lon) ;

variablel:long name = "a longer descriptive name of variable" ;
variablel:standard name = "CF_standard name here (if appropriate)" ;
variablel:units = "unit from UDUNITS" ;

variablel:valid_range = 0f,10f ;
variablel:actual_range = 1f,9f ;
variablel:ancillary variables = “variablel uncertainty variablel flag” ;
float variablel uncertainty(time, lat, lon) ;
variablel:long_name = " uncertainty associated with variablel" ;
variablel:units = "unit from UDUNITS" ;

byte variablel flag(time,lat,lon) ;

variablel flag:long name = “example flag associated with variablel” ;
variablel flag:standard name = “status flag” ;
variablel flag: FillValue = -128b ;

variablel flag:valid_range = 0b,2b ;
variablel flag:flag values = 0b,1b,2b ;

variablel flag:flag meanings = “meaningl meaning2 meaning3” ;

//global attributes:

:key variables = “variablel” ;

NB. in this example if variablel flag is a quality flag then Ob should correspond to the best quality
data.

2.5.3 Gridded data — coordinate variables

Data products from the CCI which are most likely to be used outside the community of EO (Earth
Observation) specialists are the global gridded (levels, level4) datasets. To achieve consistency across
these ECV products, and enable them to be used and understood by a wide variety of users and tools,
including the CCI Open Data Portal and CCI Toolbox, it is important to ensure consistent use of
dimensions for variables within the files.
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For consistency across CCI gridded products, variables shall have, as a minimum, the
following dimensions: time, latitude, longitude (or alternative horizontal grid)

Z
=

////‘

R-7

1. The dimensions time, latitude and longitude of a netCDF variable shall have an associated
time, latitude and longitude coordinate variable

o A coordinate variable is defined in the cf-convention as a one dimensional variable
with the same name as its dimensions (e.g. time(time), lat(lat),lon(lon), and it is
defined as a numeric data type with values that are ordered monotonically. Missing
values are not allowed in coordinate variables.

2. Itis recommended that latitude and longitude values from -180 to 180 are used.

3. All products shall have a time dimension, even if there is only a single timestep within an
individual file. This is recommended to have be of dimension = ‘UNLIMITED’. The
corresponding time variable should be an array and not a scalar variable. This allows users
to aggregate the data files along the time dimension and facilitates display of the data within
the CCI Open Data Portal.

4. Horizontal grid dimensions shall also be included.

o If coordinates other than latitude and longitude are used for the horizontal grid, then,
following the cf-conventions, it is required that the true latitude and longitude
coordinates be supplied via the coordinates attribute.

o The dimensions of any latitude or longitude auxiliary coordinate variable should be
the horizontal grid dimensions only (e.g. lat(nx,ny) ). If it is desired to describe the
mapping between the given coordinate variables and the true latitude and longitude
coordinates, the attribute grid_mapping should be used to supply this description.
For more information and examples see section 5.6 of CF-1.8.

5. For each coordinate variable in a gridded data product, the boundaries of the grid shall be
described via the use of boundary variables, as described in section 7.1 of the CF-1.8
conventions document. The boundary variable is linked to the corresponding coordinate
variable by the use of the attribute ‘bounds’, which contains the name of the boundary
variable. (see example below)

The GHRSST project (Group for High Resolution Sea Surface Temperature) has developed
conventions for non-regular latitude/longitude grids (swath) which have been adopted in the SST
community — details and examples are given in the GHRSST Data Specification document?©.

Examples can be found in the CF-conventions document and the CF Unidata NetCDF Users’ Guide,
and a simple example of CDL for CCI gridded lat/lon data is given here:

netcdf CCI_example grid {

dimensions:
time = UNLIMITED ;
lat = 1200 ;
lon = 1200 ;

nv = 2 ; //number of vertices (to define the grid boundaries)

10 See https: //www.ghrsst.org/documents/q/category/gds-documents/
11 https://www.unidata.ucar.edu/software/netedf/documentation/NUG/

Page 11/24
CCI Data Standards European Space Agency
Issue Date 26/07/2021 Ref CCI-PRGM-EOPS-TN-13-0009 Agence spatiale européenne



ESA UNCLASSIFIED - For Official Use

A
d-esa
W=
variables:
float lat(lat) ;
lat:standard name = "latitude" ;
lat:units = "degrees north" ;
lat:bounds = “lat bnds” ;
float lon(lon) ;
lon:standard_name = "longitude" ;
lon:units = "degrees_ east" ;
lon:bounds = “lon bnds” ;

double time (time) ;

time:standard name = "time" ;
time:units = "seconds since 1970-01-01 00:00:00 0:00" ;
time:bounds = “time bnds” ;

float lat bnds(lat,nv)

float lon_bnds(lon,nv)

double time bnds (time, nv)

float ecv_variable(time, lat, lon) ;

ecv_variable:long name = "a longer descriptive name of the variable" ;
ecv_variable:standard name = "CF standard name here" ;
ecv_variable:units = "unit from UDUNITS" ;

ecv_variable:valid range = 0f,10f ;

ecv_variable:actual range = 1f,9f ;

2.6 Directory structure

A common CCI directory structure has been defined.

CCI Data Producers shall use the common directory structure for all output data made
available to users

If projects need to use a different structure (e.g. due to conflicting requirements of existing user
communities), it shall be possible to map to the CCI common structure using symbolic links. The
common directory structure is based on suggestions and existing conventions used by CCI teams and
is arranged as follows:

/<archive_root>/<type>/<version>/<time>/
where each <..> may itself be complex, e.g.

<time> may be <year>/<month> or <year>/<day-in-year> or <year>/<month>/<day>
<archive-root> is /esacci/<cci_project>/

<cci_project> is e.g. <sst> or <aerosol>

<type> will be different for each ECV, but needs to be defined, and consistent within an ECV
<version> uniquely identifies the version (see Section 2.8)
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2.7  Filenaming

A common CCI filenaming convention has been developed to simplify access to the project data
across the different disciplines involved.

CCI Data Producers shall use the CCI filenaming convention for all output data made
available to users

Overview of CCI Filename Convention

Note that there are two forms that the filename can take:

1. Itcanbegin with the date and time information (which will be digits). This form is compatible
with the GHRSST filenaming convention used by Sea Surface Temperature scientists.
https://www.ghrsst.org/wp-content/uploads/2016/10/GDS20r5.pdf
Or

2. It can begin with the string ‘ESACCT in which case the date and time information will be in
the field immediately before the version information.

Overview form 1

<Indicative Date>[<Indicative Time>]-ESACCI-<Processing Level>_ <CCI Project>-<Data Type>-
<Product String>[-<Additional Segregator>][-v<GDS version>]-fv<File version>.nc

Overview form 2

ESACCI-<CCI  Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<IndicativeDate>[<Indicative Time>]-fv<File version>.nc

The fields in the filename convention are:

<Indicative Date>

The identifying date for this data set.

Format is YYYY[MM[DD]], where YYYY is the four digit year, MM is the two digit month from 01 to
12 and DD is the two digit day of the month from o1 to 31.

The date used should best represent the observation date for the data set. It can be a year, a year and
a month or a year and a month and a day.

<Indicative Time>
The identifying time for this data set in UTC.

Format is [HH[MM[SS]]] where HH is the two digit hour from 00 to 23, MM is the two digit minute
from 00 to 59 and SS is the two digit second from 00 to 59.
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@cesa

This corresponds to RDAC (Regional Data Assembly Centre) in the GHRSST filenaming convention.

<Processing Level >

Level |<Processing Description Based on
Level> Code Source
Level o Lo Unprocessed instrument and payload data at full] GHRSST
resolution. CCI does not make recommendations
regarding formats or content for data at this processing
level.
Level 1A L1A Reconstructed unprocessed instrument data at fulll GHRSST
resolution, time referenced, and annotated with ancillary
information, including radiometric and geometric
calibration coefficients and georeferencing parameters,
computed and appended, but not applied, to Lo data.
Level 1B LiB Level 1A data that have been processed to sensor units. GHRSST
Level 1C L1C Level 1b data that have been further processed, e.g. by| SMOS data
correcting radiances or by mapping onto a spatial grid, products
prior to deriving geophysical variables from the data. definition
and ESACCI
discussions
Level 2 Lo Retrlev.ed enwronmental variables at the same CEOS
resolution and location as the level 1 source . .
interoperabil
ity
handbook?2
Level 2 L2P Geophysical variables derived from Level 1 source data| GHRSST
Pre- at the same resolution and location as the level 1 data,
processed typically in a satellite projection with geographic
information. These data form the fundamental basis for
higher level CCI products.
Level 3 L3 Level 2 variables mapped on a defined grid with reduced] GHRSST
requirements for ancillary data. Three types of L3
products are defined:
L3U Uncollated (L3U): L2 data granules remapped to a space

2http://ceos.org/document_management/Working_Groups/WGISS/Documents/WGISS_ CEOS-Interoperability-
Handbook_Feb2008.pdf
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Level |<Processing Description Based on
Level> Code Source
grid without combining any observations from
overlapping orbits.
L3C Collated (L.3C): Observations combined from a single
instrument into a space-time grid.
L3S Super-collated (L3S): observations combined from
multiple instruments into a space-time grid.
Level 4 Lg Data sets created from the analysis of lower level data) GHRSST
that result in gridded, gap-free products.
Indicator IND Indicators derived from satellite data. ESACCI
<CCI Project>

This corresponds to GHRSST in the GHRSST filenaming convention.

CCI Project <CCI Project>
Aerosol AEROSOL
Antarctic Ice Sheet AIS®
Cloud CLOUD
Fire FIRE
Greenhouse Gases GHG
Glaciers GLACIERS
Ice Sheets Greenland GIS
Land Cover LC
Ocean Colour oC

13 This was formerly part of the Icesheets project and could also have <CCI Project> = ICESHEETS
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Ozone OZONE

Sea Ice SEAICE

Sea Level SEALEVEL

Sea Surface Temperature GHRSST

Soil Moisture SOILMOISTURE

Biomass BIOMASS

High Resolution Land Cover HRLC

Lakes LAKES

Land Surface Temperature LST

Permafrost PERMAFROST

Salinity SEASURFACESALINITY

Sea State SEASTATE

Snow SNOW

Water Vapour WATERVAPOUR

Further CCI projects will be added in as the programme continues.

<Data Type>

This corresponds to SST Type in the GHRSST convention and shall contain a short term describing
the main data type in the data set. Examples from Phase 1 are given in the following list. Where new
or different data types are produced in the CCI programme, the new term shall be added to the list

by informing the CCI Open Data Portal.

CCI Project Parameter

Aerosol Aerosol optical depth

Absorbing aerosol index
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CCI Project Parameter <Data Type>
Stratospheric aerosol extinction profile AEX
Aerosol type ATY
Multiple aerosol products %g R_PRODUC
Biomass Above-ground biomass AGB
Cloud Cloud cover CFC
Cloud top pressure CTP
Cloud top height CTH
Cloud top temperature CTT
Cloud optical thickness CoT
Cloud effective radius CER
Cloud liquid water path LWP
Cloud ice water path IWP
Joint cloud physical properties JCH
Multiple cloud products ,(I:.é‘ D_PRODUC
Fire Burned area BA
GHG column-averaged dry air mole fraction of CO2 CO2
column-averaged dry air mole fraction of CH4 CH4
Glaciers Glacier area GA
Ice Sheets  Ice sheet surface elevation change SEC
Ice sheet velocity v
Glacier calving front location CFL
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CCI Project Parameter

Lakes

Land Cover

Ocean
Colour

Ozone
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Glacier grounding line location

Multiple lake products

Land cover map

Condition fire (burned area)

Condition water (water bodies)

Condition snow

Condition normalised difference vegetation index
Condition albedo

Leaf Area Index

Surface reflectance

Multiple products (chla, nlw, IOPs, etc)

Phytoplankton Chlorophyll-a concentration
Normalised water leaving radiance

Remote Sensing Reflectance

coefficient for

Spectral attenuation

irradiance

Total absorption

Total backscattering

Absorption by coloured dissolved organic matter
Backscattering by particulate matter

Absorption by phytoplankton

Ozone total column

Issue Date 26/07/2021 Ref CCI-PRGM-EOPS-TN-13-0009
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<Data Type>
GLL

LK_PRODUCT
S

Map
BA
WB
Snow
NDVI
Alb
LAI
SR

OC_PRODUCT
S

CHLOR_A
NLW

RRS

K_490

ATOT
BB
ADG
BBP
APH

TC
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CCI Project Parameter

Permafrost

Sea Ice

Sea Level

Sea State

Sea Surface
Salinity

Snow

SST
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Ozone nadir profile

Ozone limb profile
Permafrost extent

Ground temperature

Active layer thickness

Sea Ice Concentration

Sea Ice Thickness

Sea Ice Extent

Corrected sea surface height
Sea level anomaly

Absolute dynamic topography
Maps of sea level anomalies
Mean sea level

Mean sea level trends

Mean sea level amplitude and phase

Significant wave height

Sea surface salinity

Snow water equivalent

Snow cover fraction — snow on groun
Snow cover fraction — viewable

Sea surface temperature

Sea surface skin temperature
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<Data Type>
NP

LP

PFR

GTD

ALT
SICONC
SITHICK
SIEXTENT
SSH

SLA

ADT
MSLA
MSL
MSLTR
MSLAMPH

SWH
SSS

SWE
SCFG
SCFV
SSTint

SSTskin
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CCI Project Parameter

Soil
Moisture

Sea surface subskin temperature
Sea water temperature

Sea surface foundation temperature

Surface soil moisture volumetric absolutes

Surface soil moisture volumetric anomalies

Surface soil moisture degree of saturation absolute
Surface soil moisture degree of saturation anomalies
Soil water index volumetric absolute

Soil water index volumetric anomalies

Soil water index degree of saturation absolute

Soil water index degree of saturation anomalies

<Product String>

\K\\\k
¢-esa

<Data Type>
SSTsubskin
SSTdepth

SSTind
SSMV

SSMVA
SSMS
SSMSA
SWIV
SWIVA
SWIS

SWISA

Each ECV team shall define the Product Strings they will use for their data and make this information
available in their documentation.

The Product String field must not include any hyphens but can include underscores.

Examples:

Example Product String |Description

MERGED

Data from more than one platform and/or sensor

AVHRR_MERGED

Data from AVHRR, more than one platform

AATSR_ENVISAT Data from AATSR on Envisat
ORAC Data from Oxford RAL Aerosol and Cloud algorithm
OPERA Data from OPERA analysis
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<Additional Segregator>

This is an optional part of the filename. It must be used if otherwise different data sets would generate
the same filename. It can also be used to include in the filename information that doesn't fit
elsewhere in the filename convention, but which projects feel is useful for easy identification of
different data sets.

Each ECV team shall define the Additional Segregators they will use for their data and make this
information available in their documentation.

More than one element may be included, separated by an underscore, not a hyphen.

Examples:

Information Example <Additional | Description
Segregator> element

Composite data <n><Y|M|D>[<n><y|m|d>] |nY or nM or nD corresponds to the period
over which data are aggregated of n number
of years or months or days.

An optional ny or nm or nd refers to the
'season' covered by the composite data set.
For example 15Y7d indicates 15 year
composite data covering a specific 7 days of
the year.

The start date and time of the earliest data
included in the composite data product will
be given by the <Indicative
Date>[<Indicative Time> |

Orbit identifier <id> where id is an orbit identifier

Ground or sea area | <code>|<tile number> code identifying the area of land or sea
covered by the data or tile number. Projects
expecting to produce regional products have
generally described codes to identify them.

Length of time period [<n>]<DAILY | MONTHLY | | Identify that data set holds n days, months or
covered. YEARLY> years data, where the filenames might
otherwise coincide.

Resolution <n>m where n is the number of metres resolution.
Processing Centre <Processing centre| name of processing centre

abbreviation>
Algorithm <Algorithm> name of algorithm

v<GDS version>

Including the version number of the GHRSST Data Specification is optional for the CCI filenaming
convention. If used it shall be 02.0
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fv<File Version>

File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and
another 1 or more digits.)

2.8 Version Numbering
The version of any given data product is specified via both the ‘product_version’ in the global
attributes and the ‘file_version’ identifier in the filenames. To meet the differing requirements of the
project teams, these two version identifiers may be used in different ways, either:
a) used to represent the same version id (i.e. with identical numbering), or
b) used separately to represent different versioned actions.
For instance, in the case of the addition of new metadata to an existing data product, this could be
represented either by a new version, with both the ‘product_version’ attribute and the ‘file_version’
in the filename incremented, or alternatively, may be considered the same ‘product_version’ but with
an incremented ‘file_version’.
The following general principles shall be adhered to:

e Version numbering shall always increase.

e The file version used in the filename shall uniquely identify the particular instance of the
dataset, and should always increase with subsequent product versions.

The file version used in the filename shall uniquely identify the particular instance of
the dataset, and should always increase with subsequent product versions.

R-10

2.9 Support for checking compliance with the data format

CCI data producers are encouraged to liaise with the CCI Open Data Portal when producing their
data formats. The Open Data Portal can provide support for checking the compliance of any datasets
to these standards.

Files can be checked for compliance with the CF convention using the on-line checking tool:
http://cfconventions.org/compliance-checker.html
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APPENDIX A — EXAMPLE GLOBAL ATTRIBUTE FIELDS

For fields coloured blue, please select terms from the CCI vocabulary at
http://vocab.ceda.ac.uk/ontology/cci/cci-content/index.html

Global Attribute Example content

title ESA CCI aerosol product level 3 daily

institution Plymouth Marine Laboratory

source MERIS FR LiB version 4.02, MERIS RR LiB version 4.02, SPOT
VGT P version 3.04

history 2011-02-14 12:22:43 - Product generated from ORAC-SW dual-
view version 2.0

references http://www.esa-landcover-cci.org/

tracking_id 0c9e9570-cd44-102f-8001-0050¢28€1010

Conventions CF-1.8

product_version 1.3

format_version CCI Data Standards vx.x

summary This dataset contains Level-3 monthly global sea surface

temperature products from satellite observations. Level-3 data are
raw observations processed to geophysical quantities, and placed
onto a regular grid.

keywords satellite,observation,ocean

id filename.nc

naming authority uk.ac.pml

keywords_ vocabulary NASA Global Change Master Directory (GCMD) Science Keywords

cdm_data_type Swath

comment These data were produced at ESACCI as part of the ESA SST CCI
project.

date_ created 20120131T120000Z

creator_name Plymouth Marine Laboratory Remote Sensing Group

creator_url http://rsg.pml.ac.uk

creator_email rsghelp@pml.ac.uk

project Climate Change Initiative - European Space Agency

geospatial_lat_min -90.0

geospatial_lat_max 90.0

geospatial_lon_min -180.0

geospatial_lon_max 180.0

geospatial_vertical_min 0.0

geospatial_vertical_max 0.0

time_ coverage_ start 20120131T070000Z

time_ coverage_end 20120131T083000Z

time_ coverage_ duration P1Y

time_coverage_resolution | P1D
standard_name_vocabulary | 'CF Standard Name Table v71'

14 For assimilation datasets the model could also be included here, e.g. “TM5 model, MIPAS L2 data
(CCI_ozone product version 1.5)”
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license ESA CCI Data Policy: free and open access
platform Envisat
sensor AATSR, MERIS

spatial_resolution

1.1km at nadir

geospatial_lat_units

degrees_north

geospatial_lon_ units

degrees_ east

geospatial_lon_resolution

0.1

geospatial_lat_resolution

0.1

key_variables

sea_surface_temperature,sea_surface_temperature_depth
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